Sorting Records in a Table

You can rearrange, or sort, the records in a table in alphabetical or numerical order, To perform a sort, you
need to indicate the field on which you want Access to sort, then specify whether to sort the database in
ascending order (alphabetically from A to Z or numerically from 0 to 9) or descending order (alphabetically
from Z to A or numerically from 9 to 0). For example, in a customer database, you could sort records by the
Sales field in descending order to quickly identify the customers who purchased the most products. You
might also want to sort records using more than one field. For example, you might wish to sort primarily by
state but also by customer name, so that the records for each state are grouped together, with customers
listed in alphabetical order within each state grouping. m Serena asks you to create a sorted list that
groups the records first by Rep ID and then, within each Rep ID grouping, by YTD Orders in descending

m order. First, you experiment with sorting in different ways.

J)(' ”‘mwv 1. Click the Shutter Bar Close button (] in the Navigation Pane
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The database window now displays the Customers table with all its fields in view. Just to experiment, you

ke? decide to sort the table in ascending order by customer name.
f 2. Click any field in the Customer column
| Before performing a sort, you tieed 10 select the field by which you want to sort.

3. Click the Ascending button in the Sort & Filter group on the Home tab

[, ’ﬁ‘f'\"‘]i’ /1 N“’V? The table is now sorted by customer name in alphabetical order, with Al's Sports Hut listed first. Notice that
e , there is a small upward-pointing arrow to the right of the Customer column header, indicating that the table
s sorted in ascending order by this field, as shown in Figure K-4.

4. Click the Descending button in the Sort & Filter group on the Home tab

if you select ETND clgll-k The table is now sorted by customer name in descending alphabetical order (Z to A), with Wilderness Outfitter
girt';]gsr 't';: E C;di% listed first. Notice the downward-pointing arrow in the Customer column heading, indicating that the records
or the Descending in the table are sorted in descending order by this field.

— ill . 3 "

/ E;??Qn tﬁ‘;cf:éov:és 5. Click the Remove Sort button in the Sort & Filter group
~——— —e e . .
* |inthe |E%Ufﬂﬂ, The table is now ordered in its original order, with Country Goods listed first in the Customer column.
then cords - . . . . .
’2- in the right column. 6. Click any field in the YTD Orders column, then dlick the Descendin button in the Sort &
NPl .
Filter group

The records are now sorted in descending order by year-to-date order amounts. You see that Hiking Emporium
has purchased the most this year, with §75,764.00 in the YTD Orders field value text box.

7. Click any field in the Rep ID column, then click the Ascending button in the Sort &
Filter group
“The records in the Customers table are now sorted first by Rep ID in ascending order and then, within each
Rep ID grouping, by YTD Order amounts in descending order, as shown in Figure K-S.

8. Click thé_ Remove Sort button in the Sort & Filter group
The table reverts to its original order,

[oeardty 2. pans 4

Capturing a screen shot of your sar}fzéd table

QUICKTIP
To capture a screen
shot of your sorted
table after Step 7,
follow the instruc-
tions in the yellow
box below.

Your instructor might ask you to capture a screen shot of the sorted your sorted table is pasted into a new word document. Save this
Customers table and submit it. To do this, start Microsoft Word, click document as Unit K Screen Shots and submit it to your instructor.

’} the Insert tab, click the Screenshot button, then click the image of Click the Access program button on the taskbar to return to Access.
the screenshot in the Available Windows menu. The screen shot of
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Filtering Records in a Table

Just as you can apply a filter to an Excel worksheet to display only the information that you want to see, you
can also apply a filter to an Access table to display only those records that mee{_criteria that you specify.
Criteria are conditions that must be met for a record to be displayed. For example, you might want to filter

a database to see only the records for customers who are lo in Florida, or only those for customers who
B

made a purchase within the past three months. The simplest way to filter a table is to select a field that
matches your criterion (for instance, a State field containing FL), and then use the Equals command to
display those records that match the selection. You can also apply a Number Filter to a selected field to filter
records that are greater than, less than, or equal to a specific number, or between two different numbers.
You cannot save a filter as a database object, but you can save it as part of the table or form you are working
on and reapply it the next time. You can also print the results of a filter. m Serena needs you to print a
list of customers whose year-to-date orders are greater than $5000 for sales rep Jose Garcia. You decide to
apply filters to display records that meet these criteria.

When a filter is
applied to a table,
the word “Filtered”
appears in the
record navigation
bar; when you click
the Toggle Filter
button, the naviga-
tion bar displays
“Unfiltered”. If no
filter is applied, the
navigation bar dis-

plays “No filter”.
e

To capture a screen
shot of your filtered
table after Step 7,
follow the steps in
the yellow box in
the previous lesson.

1. Click a field in the Rep ID column containing the value R-1999
This Rep ID number (R-1999) is the ID number for Jose Garcia, a rep in the West region.

2. Click the Selection button in the Sort & Filter group
The Selection menu opens and displays four commands. These commands let you filter records that are equal
or not equal to the selected field value, or that do or do not contain the selected valye,

3. Click Equals "R-1999"
Seventeen records containing R-1999 in the Rep ID field appear in the datasheet window, as shown in
Figure K-6. These records are all Jose Garcia’s customers. Notice that a filter icon appears to the right of the
Rep ID column heading, indicating that a filter is applied to this field, -

4. Click the Toggle Filter button in the Sort & Filter group

The filter is removed, and all the records in the table appear again. Clicking the Toggle Filter button once
removes the filter; clicking it again reapplies it.

3. Click the Toggle Filter button

The filter is reapplied, so that only the 17 customer records for 1ep R-1999 (Jose Garcia) appear.

6. Click any value in the YTD Orders field, then click the Filter button in the Sort &
Filter group —
The Filter menu opens and displays commands for filtering and sorting records specific to the YTD Orders
field. The bottom of the list displays all the specific values for the YTD Orders field, with check boxes next to
each. To show only records with one of these specific values, you can click the check box next to that value.
You want to display records that are greater than 5000, so you need to use a Number Filter command,

7. Point to Number Filters in the Filter list, click Greater Than, type 5000 in the Custom Filter
dialog box, compare your screen to Figure K-7, then click OK
The filtered list now shows ten records, with two filter criteria applied. All the records contain R-1999 in the
Rep ID field, and all the values in the YTD Orders field are greater than 5000, as shown in Figure K-8.

8. Click the Toggle Filter button, then save your changes
The filter is removed, and your changes are saved.
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Creating a Query Using the,, ,
J ‘?a%/yyw% fﬁ/g 7"“’?2 f%/} 2

Query Wizar

“qabe o J i}

Filtering data in tables is helpful, but it has some limitations. For one thing, you cannot limit or chéﬁd’e he &
order of the fields Access displays when you apply a filter. You also cannot save a filter, For greater flexibility -
and control, you need to use a query. A query is a database object that extracts data from one or more &

tables in a database according to criteria that you set. A query displays only the fields you specify. For -
instance, in a database that contains ten fields that store product information, you could create a query that &
displays only the fields for product names and prices. You can also use a query to pull together information
from several tables. Because a query is an object, you can save it for later use. The simplest way to create a
query is to use the Query Wizard. S8 Serena wants to see a view of the data that shows customer

m names, their state, and Rep ID numbers. To accomplish this, you decide to use the Query Wizard.

1. Click the Customers table_Close button B in the database window, then click the Shutter
Bar Open button 2]
You need to close a table before creating a query that is based on it. The Navigation Pane is now open.

&

=

=

&

e

. . . ' ©
2. Click the Create tab, then click the Query Wizard button in the Queries group .
The New Query dialog box opens, as shown in Figure K-9, where you select the type of Query Wizard you e }
o

e

&

e

e

want to use. By default, Simple Query Wizard is selected. This wizard creates a select query, a query that
retrieves or selects data from one or more tables or queries according to your criteria. This is the most
commonly used type of query and is the one you want to create.

3. Click OK
The Simple Query Wizard dialog box opens. First you need to specify the table or query from which you want
to select fields for your query.

4. Click the Tabl ies list arrow, then click Table: Customers ‘
Notice that all the fields from the Customers table are listed in the Available Fields list. You now need to H
choose the fields you want from this list. [
QUICK TP 3. Click Customer in the Available Fields list, then click the Select Single Field button [Z] CJI
:(;ilélija g ;gg :E::Ct The Customer field moves to the Selected Fields list. You can move fields back and forth between the Available ” ]

Fields list and the Selected Fields list using the buttons shown in Table K-1.

6. Click State, click [5], click Rep ID, then click [
Now the Customer, State, and Rep ID fields are listed in the Selected Fields area, as shown in Figure K-10.

7. Click Next
In this dialog box, you specify a name for the query. Unless you specify otherwise, the Query Wizard will
automatically name the query “Customers Query”, which is currently in the text box.

8. Select Query in the text box, type by State, then click Finish
The Query Wizard closes and the Customers by State query results appear in Datasheet view, showing the
Customer, State, and Rep ID fields. Notice that the Customers by State query is now listed in the Navigation
Pane below Sales Reps: Table, as shown in Figure K-11. This query contains only fields that Serena needs to
see. She can now sort and apply filters to the query to get just the information she needs.

clicking its name
in the Available
Fields list.

QUICK TIP

Records resulting
from a query look
like a table but are
actually a view
based on the query.

9. Save your changes

P ~ %J/.,:QCVA{'””J
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Modifying a Query in .;
Design View

You can modify an existing query if you need to make changes to it using Design view. In Design view, you
can add or delete fields, specify a sort order for one or more fields, or specify criteria for fields, You can also
use Design view instead of Query Wizard to create a query. m Serena asks you to modify the Customers
by State query so that it includes the YTD Orders field. She also wants the results to be sorted by YTD Orders
in descending order. In addition, she wants you to create another query based on the Customers by State

m query that displays customers in the state of California. You decide to create this new query in Design view.

1. Click the Home tab, then click the View button in the Views group
The databmdisplays the Customers by State query in Design view, and the Query Tools Design tab
Is active. In Design view, the database window is divided into two panes. The upper pane displays the
Customers table field list. The lower pane is called the query design grid. You use the cells in this grid to
specify fields and their criteria for the current query. The query design grid currently contains the three fields
in the Customers by State query (Customer, State, and Rep ID). Notice that the check box in the Show cell
under each field contains a check mark, indicating that these fields should be displayed in the query.

i)

=AY
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=

QUICK TIP 2. Scroll down the Customers table field list in the upper pane, then double-click YTD Orders
zollé Ci“ ;']50 add The YTD Orders field is now added to the query design grid and appears in the fourth columnn,
ields to the query " . " i . ;
design gridbydrag- | 3, Click the Sort cell for the YTD Orders field in the query design grid, click the Sort list
ging them from the : ;
kMl arrow, then clldgﬂe_s_cgn_d;_nq\
See Figure K-12.
4. Click the View button in the Results group
The query results appear in Datasheet view, and the records are sorted by the YTD Orders field in descending
order. As you modify a query, it is convenient to switch back and forth between Design view and Datasheet
view to see the modified query results, as shown in Figure K-13.
5. Click the Save button [ on the Quick Access toolbar, then click the View button in the
Views group
i R 37155

The changes you made to the Customers by State query are saved, and the query appears in Design view.

6. Click the 2 Criteria cell for the §t_a{te field in the query design grid, type ca, then press [Enter]
After you press [Enter], quotation marks appear around your entry. The criteria “ca” specifies that the query
results should only display records that contain CA in the State field.

7. Click the View button in the Results group
The query results appear in Datasheet view, as shown in Figure K-14. The results show seven records that

—contain CAin the State field. Notice that the records are sorted in descending order by YTD Orders.

8. Click the File tab, click Save Object As, type Califomi_ELCust(_)_r_ners in the Save ‘Customers

by State” to text box in the Save As dialog box, then click OK

The modified query is saved as California Customers and appears in the Navigation Pane below
Customers: Table,

- D - 9. Click the Home tab, then click the California Customers query Close button B
) &JA/ o The California Customers query closes, fﬂ& F‘l/e&r

e b @ﬁ*@w Y

QUICK TIP
Criteria that you
type are not case
sensitive; typing
"WA”" in the Criteria
cell displays records
with “WA”, “wa”
“Wa", or “wA" in
the State field.
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Select the best answer from the list of choices.

13. Which of the following cannot be saved as an object in Access?

a. A query ¢. Aform
b. A table d. A filter
14. Which of the following shows how the Year 1 Sales field would appear in an expression?
a. =Year 1 Sales c. [Year 1 Sales]
b. <Year 1 Sales> d. (Year 1 Sales)

15. Which of the following is not possible to do in Query Design view?
a. Specify a relationship between two fields in two tables,
b. Specify criteria for a field in a query.
c. Specify a sort order for one of the fields in the query.
d. Add a field to a query.
16. To apply a filter that displays all the records that display Ohio in the State field, which of the following
actions would you take?
a. Click the Filter button, then type Ohio.
b. Click Ohio in the table, click the Selection button, then click Equals Ohio.
¢. Click any field in the table, click the Selection button, then click Equals Ohio.
d. Click the State field name in the column heading, click the Selection button, then click Equals Ohio.
17. Which of the following cannot be included in an expression?
a. Fields c. Field descriptions
b. Mathematical operators d. Values
18. Table A and Table B are related in a one-to-many relationship. Table A is on the “one” side of the
relationship, and Table B is on the “many” side of the relationship. Which of the following statements
about these tables is NOT true?
a, In Table A, the shared field is the foreign key.
b. In Table B, the shared field is not the primary key field,
¢. The shared field is the foreign key in Table B.
d. One record in Table A is related to many records in Table B.

p~]
[z
(1)
(1]
127
(7]
N
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Skills Review ode

1. Open an existing database.

a. Start Access,

b. Open the Data F% K-Z,.ac&db from the drive and folder where you store your Data Files. Specify to enable the content
in the database.

c. Save the database as a new database with the name K-Puzzle Universe.accdb. Enable the content.

d. Open the Suppliers table in Datasheet view, and review the fields and records it contains. View the Products table in
Datasheet view, and review its fields and records.

€. View each table in Design view. Note the number of fields in each table and the data type assigned to each.

f. Close the Suppliers table,

2. Sort records in a table.

a. View the Products table in Datasheet view. Close the Navigation Pane.

b. Sort the table by the Puzzle Name field in ascending order. What is the product ID of the first record in the sorted list?
Reverse the sort order so that the records are sorted descending by Puzzle Name. What is the product ID of the first
record now?

c. Clear all sorts, so that the records appear in their original order.

d. Sort the table by the Units Sold field in descending order. What is the Puzzle Name of the first record? Then sort the
table by the Category field in ascending order. Now what is the Puzzle Name for the top record in the sorted list?

e. Select the first Puzzle ID value (11242), then type your name. Save your changes to the Products table, [f your instruc-
tor asks you to provide a screen shot of your sort results, follow the instructions in the yellow box on page 248.

Working with Data
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lls Review (continued)

3. Filter records in a table.

a.

b.
C.

d.

Apply a filter to the Products table to show only records that contain the field value Cityscapes in the Category
field. How many records are displayed with the filter applied? What is the Puzzle Name of the first record?

Remove the filter using a button on the Home tab.

Apply a Number filter to show only records with values greater than 17500 in the Units Sold field. How many records
are displayed with the filter applied? What is the Puzzle Name for the last record?

Save your changes. If your instructor asks you to provide a screen shot of your sort results, follow the instructions in
the yellow box on page 248. Remove the filter, then save your changes.

4. Create a query using the Query Wizard.

a.
b.

d.

€.

Close the Products table, then open the Navigation Pane. Create a new query using the Simple Query Wizard.
Base the query on the Products table, and include the Puzzle Name, Target Age Group, and Units Sold fields in
the query.

Name the query Puzzles by Target Age Group, then finish the Wizard and view the query results in
Datasheet view.

Sort the query in ascending order by the Target Age Group field.

Save your changes.

5. Modify a query in Design view.

AL TP

f. Close the Nature Units Sold query. | — 3 w i
X [ 6.)Relate two tables. T
a. Open the Relationships window. ,_-__IT‘?EF‘,&C’_U ‘ _ Bandup ... 2653 Nature
b. Add the Products table to the Relationships window, | |GrandCanyon — sandup o 13436 Nature
then add the Suppliers table to the Relationships - g — LI —toNie
Palm Traes ‘Band up 13453 Nature
window. Close the Show Tables dialog box. ' Rain Forest Band up T 12975 Nature
¢. Drag the Supplier ID field from the Suppliers tableto | Lake . 8andup . 12098 Nature
the Supplier ID field in the Products table. o Beach ~  _ 8andup . oL

d. Specify to enforce referential integrity, then create

€.

f.

View the Puzzles by Target Age Group query in Design view.

. Add the Category field to the query design grid,

Set the sort order to Descending for the Units Sold field.

+ Use the query design grid to enter the criteria Nature for the Category field.

View the query results in Datasheet view. Use the Save Object As command on the File tab to save the modified query
as Nature I.Imts Sold. Compare your ./FI GURE K-75
datasheet to Figure K-25.

the relationship.

View the tables in the Relationships window, and make sure there is a one-to-many relationship set between the
Supplier ID fields.

Save your changes, then close the Relationships window.

7.|Create a query using two tables. -

a.
b.

e oA

Create a new query in Query Design view.

Use the Show Table dialog box to add the Suppliers table and the Products table to the upper pane of the query design
window. Close the Show Table dialog box.

Notice the relationship line between the Suppliers table and the Products table.

» Add the Puzzle Name and Units Sold fields from the Products table to the query design grid.

Add the Supplier Name and Contact Email fields from the Suppliers table to the query design grid.
In the Criteria cell for the Units Sold field, enter an operator and value that will return records with values greater
than 20,000.

Working with Data
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Skills Review (continued)
& Set the Units Sold sort order to Descending.

h. View the query results in Datasheet view. Typ

Top Puzzles by Supplier.
1. Compare your datasheet to
Figure K-26. Close the query.

[Tomado T

% 8. Add a calculated field to _YourName B
a table, _Saturn
a. Open the Products table in . Satellites
Datasheet view, then close the —t gxk i
Navigation Pane, Voleano
b. Add a calculated field to the table | (Pizza
with the Currency data type, - i
: . 3 Mona Lisa
¢. In the Expression Builder dialog | Bocton
box, enter an expression that  Airplane
multiplies the Net Price field by
. s — _ . tondon
th%ld. (Hint: The
multiplication operator is *,) _'TheScream

Click OK to close the Expression

. ... 32765 Lee Industries o

Chocolates "

i il S
P T e

78654 Choy Paper Proddcfs

76456 Choy Paper Products
54667 Lee Industries

(ASBT6 Lee Industries
38763 Lee Industries

28987 Lee Industries

| 28654 Korea Paper Traders

28377 Morales Paper

Supplier Name
78976 Morales Paper

-

Contact Em-a;ii r
esme@planktonps.com

imoi@igejn_d_gs‘rﬁgs.com

‘ !'_r_n_c_)ir@l_eeindustries.com

. Imoi@leeindustries.com
Imoi@leeindustries.com
. nancy @kpt.com

. esme@pianktonps.com
. Inyau@choypaperproducts.com
_ hancy@kpt.com

7 esme@pl_gnktdﬁbg;cha

Imof@lerejnqqs;rigsr.corp

mq@l_e_eindus:ri_es.com

Builder dialog box.
d. Enter the field nam : or the new field. Increase the width of the column so that the entire field name
is visible,

e. Save your changes, close the Products table, then clos

your instructor.

Independent Challenge 1

database to manage the data about each counselor and camper.
and counselors 5o that he can make appropriate plans for the summer session.

a. Start Access, then open the Data Fi

the content in the database. Save the datab
each table in the database, and review the
b. View the Counselors table in Datasheet vi

€cdb from the drive and folder where
ase as K-Bay Town Sports Cam
fields and records of each,
ew. Replace Johnson in the Counselor Last Name field with your last
elor First Name field with your first name. Sav
¢. View the Campers table in Datasheet view, then sort the table by the Age field in ascend;

Campers table in ascending order by Counselor ID.

_ d. Apply a filter to the Campers table so that only the campers for Counselor ID CO-
w1 e filter to show only the campers who are 11 and un

e. Create a simple query using the Query Wizard, Base the query on the Ca
First Name, Camper Last Name, and Age. Name the query
results in ascending order by the Camper Last Name field,

with your name. Save your changes,

He wants you to answer some

e the database. Exit Access, Submit your completed database to

ng in for the summer session, Jorge has created a

e and cl

questions about the campers

you store your Data Files, Enable
P, and enable the content. Open

ose the Counselors table,

ng order. Then sort the

mpers table, and include the fields Camper

Campers Query. In Datasheet view, sort the query

and then by Age. Replace the first name of the first camper

Working with Data

€ your name in the first cell in the Puzzle Name field. Save the query as

FIGURE K-ZG—/ﬁ
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~ ' Units Sold -~

&

s lirnyau@choygaperproduc’t_s..-com
iiqygq@ghoypaperp{oduct;.com

Access 265

0L0Z sseaay




f. Open the Campers Query in Design view. Add the Counselor ID field to the query. Add appropriate criteria to one of q
/wj’ the Sort cells in the query design grid specifying to show only the records containing 110 in the Counselor ID field X
; View the query results in Datasheet view, then save the modified query as CO-110 Campers. Close the query. K
8. Open‘the Relationships window, then add the Counselors table and the Campers table to the window, o
h. Drag the Counselor ID field from the Counselors table to the Counselors ID field in the Campers table. In the Edit .
Relationships dialog box, specify to enforce referential integrity, then create the relationship. a2
i. Save the layout of the relationship, then close the Relationships window. -
ﬁ j. Create a new query in Query Design view. Add the Counselors table and the Campers table to the grid. Use the appro '
priate tables to add the following fields to the query design grid in this order Camper First Name, Camper Last Name €
Age, Counselor First Name, Counselor Last Name, and Sport. y |
J k. Set the sort order for the Age field to Ascending. Set the criteria for the Sport field to Soccer. G
1. Save the query as Soccer Campers. View the query results in Datasheet view, then close the Soccer Campers query. &)
Advanced Challenge Exercise 2
B Create a new table, and save it as Sports. Change the ID field name to Sport, and apply the Text data type to it. =
% Add a second field named Cost, then apply the Currency data type to it
‘ B Enter five records into the tabje using the following information:
' Sport Cost - &
Gymmnastics $250
Soccer 3350 &
Tennis $300 &
Volleyball $250 =
B Close the table, Open the Relationships window, then set Up 4 one-to-many relationship with the Sport field in the ol
Sports table to the Sport field in the Counselors table. (Hint: Add the Sports table to the Relationships window; Drag 3
the tables in the Relationships window so that the Sports table appears to the left of the Counselors tabje ) Specify o
to enforce referential integrity. Save the layout of the relationship, then close the Relationships window, P

J m Save the query as Camper Payments Due. View the query results in Datasheet view, then close the query.
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Relating Two Tables

To take advantage of the full power of Access, you sometimes want to create I fields from

_more than ore-tahle, For instance, the queries you created in the previous lesson pulled from a single table,
5

the Customers table, but it would have been helpful also to include the Rep Last Name field from the Sales

;]QREPS table. This is possible if you first relate the two tables, or specify a telationship between them. To do
= 50, your tables must share a common field, and that shared fiel

NS = ’ d must be the ;:;rirnary key field in one of the

UNIT

Access 2010

common type of relationship to set up is a one-to-many relationship, in which the primary key field in
one table is associated with multiple recordmﬁmmu need to specify a one-to-many

"~ relationship between the Sales Reps table and the Customers table so that you can create queries that pull

m fields from both tables.

1. Click the Database Tools tab, then click the Relationships button in the Relationships group
The Relationships window opens. It is currently empty, because there are no related tables or queries in this
database. To set up relationships, you first need to choose the tables you want to relate,

2. Click the Show Table button in the Relationships group
The Show Table dialog box opens, with the Tables tab in front and the Customers table selected, as shown in
Figure K-15. You use this dialog box to add specific tables or queries to the Relationships window, so that you
can specify relationships among them.

3. Click Sales Reps, click Add, click Customers, click Add, then click Close
The Show Table dialog box closes, and the Relationships window displays the Sales Reps and Customers
tables. Notice that in the Sales Reps table, the Rep ID field is the primary key field, but in the Customers table,
the Rep ID field is not the primary key field. This is appropriate; in order to relate two tables, the shared field
must be a primary key field in only the first table. In the second table, the common field shared with the first

table is called the foreign key, To create a one-to-many relationship, you need | to drag the primary key from

the first table to the foreign key in the second table,
‘—-“—_'—'——__—-—_»____

Iv*i( 4. Drag the Rep ID field from the Sales Reps table to the Rep ID field in the Customers table

A x ~ The Edit Relationships dialog box opens. The Current settings reflect the relationship you just specified by
T \\ . dragging. The Rep ID field from the Sales Reps table is on the left, and the Rep ID field from the Customers
Ny k table is on the right. At the bottom, the Relationship Type is listed as One-To-Many. These settings are exactly
£ M what you want; one sales rep is associated with multiple customers, but each customer is associated with a

single sales rep. Therefore, it makes sense to set up a one-to-many relationship with the Rep ID field in the
Sales Reps table on the “one” side of the relationship, and the Rep ID field in the Customers table on the
“many” side.

5. Click the Enforce Referential Inte rity check box to add a check mark
Selecting this check box tells Access to Teject any attempts to enter data that would be inconsistent. For

\ ‘I'\ g
\‘ &‘}( {\@}‘) instance, if a user entered “55” as a Rep ID number in the Customers table, Access would reject the entry
\ because that Rep ID number does not exist in the Sales Reps table. See Figure K-16.

: \v
\,J( £ ’(’» é\b\ 6. Click Create

A rela‘t;mm"h\ipljne now connects the Rep ID field in the Sales Reps table and the Rep ID field in the Customers

. Ay Jv table, as shown in Figure K-17. Note that there is a 1 at the top of the line and an infinity symbol at the
. \~\[’ )1\\ { bottom of the line, indicating that these two fields have a one-to-many relationship.
v

QUICK TIP 7. Click the Save button B on the Quick Access toolbar, then click the Close button [B]in
When you make the Relationships group :
_ ‘ LY

changes to the rela-
eyl 0
/ @Jﬂ) LI/ 7\ #
| 2 L

tionships in a data-
base, you need to
save your changes,

tables. You use the Refatiosﬁips window to specify a relationship between two or more tables. The most

ud




UNIT

Access 2010

Creating a Query Using
Two Tables

Setting up relationships between tables offers many advantages. One is that you can create a query that
pulls fields from two or more related tables. Also, if you specify to enforce referential integrity in related
tables, any changes you make to fields in one table are instantly reflected in all related tables or queries that
contain that field. This is a huge benefit and ensures that the data in your database is consistent. Setting up
table relationships also ensures that your data is valid and accurate. Access will prohibit any attempt to enter
data in the foreign key field that is not consistent with the data in the primary key field. m Serena
would like a view of the data that shows customers whose year-to-date orders exceed $1 0,000. Because you
have set up a one-to-many relationship between the Sales Reps table and the Customers table, you can
create a query that contains the information Serena needs.

TROUBLE
If the Show Table
dialog box is cover-
ing the field [ists,
drag its title bar to a
new location,

To delete a field
from a query, click
anywhere in the
field column in the
query design grid,
then click the Delete
Columns button

in the Query
Setup group.

To specify multiple
criteria for a field,
type additional crite-
ria in the Or cell for
that field in the query
design grid; results
willinclude any
records that match
either the Criteria cell
contents or the Or

cell contents.

query results by
clicking the Run
button in the

Results group in

Design view.
S
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You can also view

1. Click the : Create tab, then click the Query Design button in the Queries group
A new blank query opens in Design view, and the Show Table dialog box opens with the Customers table
selected.

2. On the Tables tab of the Show Table dialog box, click Sales Reps, click Add, click
Customers, click Add compare your screen to Figure K-18, then click Close
The field lists for the Sales Reps table and the Customers table appear. Notice that the relationship you created
between the Rep ID field in the Sales Reps table and the Rep ID field in the Customers table is shown.

3. Inthe Sales Reps field list, double-click Rep Last Name, then double-click Region
- 2dI€S REPS 1€  Ep Ldst IName, the g
The Rep Last Name and Region fields are added to the query design grid.

4. In the Customers field list, double-click Customer, double-click State, then double-click

YTD Orders =
o S
3. Click the Sort cell for the YTD Orders field, click the Sort list arrow, then click Descending
s . — _

6. Click in the Criteria cell for the YTD Orders field, then type >10000
This criteria specifies that the query results should only display records whose YID Sales field value is greater
than 10,000. The greater than symbol (>) is one type of operator you can use in the Criteria cell to return the

query results that you want. Table K-2 displays useful comparison operators.

7. Click the Sort cell for the Rep Last Name field, click the Sort list arrow, click Ascending,
then compare your screen to Figure K-19

8. Click the View button in the Results group
The query results appear in Datasheet view, as shown in Figure K-20. You can see that the results are grouped
first by Rep Last Name in alphabetical order, then by YTD Orders in descending order,

9. Click the Save button &l on the Quick Access toolbar, type Top Customers by Rep in the
Save As dialog box, click OK, then close the Top Customers by Rep query
The query is saved as Top Customers by Rep and appears in the Navigation Pane. It appears in both the
Customers grouping and the Sales Reps grouping because it contains fields from both of these tables.

g Loy 2,
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orders for each customer. You need to create 3 calculated field that adds the Prior Year Orders field to the

m YTD Orders field.

1. Open the Customers table in Datasheet view, then click the Shutter Bar Close button
The Customers table opens in Datasheet view,

2. Scroll to the right until you see the last field in the table and the blank field to the right
of it

3. Click Click to Add, point to Calculated Field, as shown in Figure K-21, then click Currency
The Expression Builder dialog box opens, which lets you build the expression using fields, values, and
mathematical operators. You need to build an expression that sums the Prior Year Orders field and the YTD
Orders field.

4. _Double-click Prior Year Orders in the Expression Categories section
The Prior Year Orders field appears in the top part of the dialog box in brackets. This field is the first part of
yo ssion. Next you need to enter the addition operator.

5' @
Y the plus sign (the addition operator). You can now add the YTD Orders field to complete the
expression.

QUICK TIP 6. Rouble-click YTD Orders in the Expression Categories section
:‘ertj ]Eh?é? fa';tgl The top section of the dialog box shows the completed expression, as shown in Figure K-22.
ated field in a table ;
Lanonlyindude | 7. Click OK
The new column (next to Prior Year Orders) is now populated with currency values, which are the result of the

field references tq
expression you built (Prior Year Orders + YTD Orders). You need to type a label for this field. The placeholder
label is selected, 50 you can type a new label,

QUICK TIP
Unlike Excel formu-
las, expressions do
not start with an
equal sign (=).

BAR K NUNCN W I N

o

2,442

: =

0 ) F 8 Typ | Orders, then press [Enter] }

/f ~ I Y] e The field name Total Orders now appears as the last field name in the table, as shown in Figure K-23. @:j
LB 9. Click &, dlick the File tab, click Close Database, then click Exit &

1\9 The Customers table, the database, and Access all close, &J

BE s
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Real Life Independent Challenge

: You can use relational databases to help you manage information in your own life. For instance, you could create a database to
. - track your personal EXPEnses, your assets, or your music collection. In this Rea] Life Independent Challenge, you create 3 data-
’L\/ L » Dase to help you keep track of your classes,
3 ]

a. Start Access, then open the Data File K-6.accdb from the drive and folder where you store your Data Files, Enable
the content in the database. Save the database as K-My Class Information.

b. Open the Classes, Professors, and Books tables in Datasheet view, review the fields that each contains, and identify the
data types for each field,

vvvuvo‘ooﬂi’d'

Relationships window.
e. Create a new query in Design view, Display the Professors, Classes, and Books tables (in that order) in the Upper pane.
| Save the query as MyBook List.
f. Add the following fields to the query design grid in the order specified: Book Title, Author, Class Name,
Class Schedule, Professor Last Name, Data Entered By. View the query results in Datasheet view,
| then type your name in the first Data Entered By field. Save your changes.
8. Close all open objects, then exit Access. Submit your completed database to your instructor,

0L0Z sseaay
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Independent Challenge 2

You manage the Fiesta Dance Studios. You have created an Access database to manage information about your classes and your
students. In preparation for upcoming classes, you want to filter and query the data.

Y s
F r

a.

b.

+ Return to Design view, then set the criteria for the Class Name field as Tamgo. Set the sort order to Ascending for the

. View the Students Class List query in Datasheet view. Observe your name in the Instructor Last Name field for the

Start Access, then open the Data File cdb from the drive and folder where you store your Data Files. Enable
the content in the database. Save the 3 atabase as K-Fiesta Dance Studio.

Open the Students table in Datasheet view, then filter the data to show students who are signed up to take the class
with Class Code 2014. Sort the filtered results in alphabetical order by the Last field. Type your name in the Data
Entered By field for the first filtered record, then save your changes. If your instructor asks you to provide a screen shot
of your results, follow the instructions in the yellow box on page 248. Remove the filter, then close the table.

. Use the Relationships window to create a one-to-many relationship from the Classes table to the Students table using

the Class Code field. Specify to enforce referential integrity in the Edit Relationships dialog box. Save the relationship,
then close the Relationships window.

- Open the Classes table. Add a calculated field to the table that has the Currency data type. Build an expression for this

new field that multiplies the Sessions field by the Fee Per Class field. Name the field Total Cost.

- Create a new query in Query Design view. Use the Show Table dialog box to open both the Classes table field list and

the Students table field list. Close the Show Table dialog box.
Add the following fields to the query design grid: First, Last, Class Name, Start Date, Instructor Last Name, and
Total Cost,

. Set the sort order to Ascending for the Class Name field. Use the Save Object As command on the File tab to save the

query with the name Students Class List. View the query in Datasheet view,

Last field. Use the Save Object As command to save the modified query as Tango Class List. View the query results
in Datasheet view.

Click the Classes table tab in Datasheet view. Select Howard in the Instructor Field for the Tango class, then type
your name,

Save and close the Classes table. Now look at the Tango Class List query in Datasheet view, and observe the change in
the Instructor Last Name field. Close the Tango Class List query.

=
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Tango class. Close the Students Class List query.
Close the database, then exit Access.

I




Independent Challenge 3

You own a small, residential pet-care business called We Love Pets. You employ three people who make service calls to clients
and care for their pets. You have created a database to help you manage information about your clients and their pets as well

™\

a.

b.

as your pet-care providers. You need to create a schedule for your Friday appointments that combines information from two
tables in your database. You also need to create some handouts for your pet-care providers that list schedule information and
service notes. You first need to relate the two tables, then you will use queries to create the schedule and handouts you need.

Start Access, then open the Data File K-5.accdb from the drive and folder where you store your Data Files. Enable
the content in the database. Save the database as K-We Love Pets and enable the content.

Open each table in Design view, and review the fields and field types each contains. Note which fields are the

primary key fields. Get a sense of the information that each table contains. Close both tables when you have finished
reviewing them.

Open the Relationships window, then establish a one-to-many relationship between the Care Provider ID field in the
Care Providers table and the Care Provider ID field in the Clients table. Specify to enforce referential integrity. Save the
relationship, then close the Relationships window.

. Open the Care Providers table. Replace Aglio in the Last Name field for the first record with your last name. Replace

Julio in the First Name field for the first record with your first name.

. Add a calculated field in the Care Providers table that has the Currency data type. Build an expression for this field

that multiplies the Hours Per Week field by the Hourly Rate field. Name the field Weekly Pay. Close the Care
Providers table.

Create a new query in Query Design view. Use the Show Table dialog box to open the field lists for the Care Providers
table and the Clients table, then close the Show Table dialog box. Save the query as My Friday Schedule.

- Add the following fields in the order listed to the query design grid: Day to Visit, First Name, Last Name,

Client Name, Street Address, Pet Name, Animal, and Visit Time.

. Enter Friday as the criteria for the Day to Visit field. Enter your first name as the criteria for the First Name field. Save

your changes.

View the query results in Datasheet view.

Switch back to Query Design view, then save the query as My Cat Visits. Delete “Friday” in the Criteria cell for the
Day to Visit field. Enter cat as the criteria for the Animal field. View the query in Datasheet view, then save and close
the query.

- Create a new query in Design view that pulls from both database tables and contains the following fields: Last Name,

Client Name, Pet Name, Service Notes. Set the criteria for the Last Name field to SlatsKy. Save the query as Slatsky
Weekly Service Notes. View the query results in Datasheet view.

Advanced Challenge Exercise

A
(O
B

L

® Return to Query Design view,

B In the Or cell for the Last Name field, enter Grasso. (Hint: This cell is below the Criteria cell.)

B Add the Day to Visit field, enter Monday in the Criteria cell, then enter Tuesday in the Or cell for the Day to
Visit field. Set the sort order to Ascending for this field.

B Save the query as Mon and Tues Notes for Slatsky and Grasso. View the query results in Datasheet
view, then close the query.

Close the database, then exit Access.
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Visual Workshop

purt 7~

Open the Data Fi@db from the drive and folder where you store your Data Files, enable the content, then save it as
K-Teen Charity Race. Enable the content. Create the query shown in Figure K-27 using fields from t

tables in the database. Specify the appropriate sort order for the Biker Last Name field and the appropriate ¢
Charity Name field. View the query in Datasheet view, then replace the sponsor name for the first record with
Save the query as Red Cross Donations. Close the database, then exit Access. Submit your completed da

your instructor.

FIGURE K-27
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